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Quand l'application Web interro-
ge correctement la base de don-
nées, elle effectue les calculs, 

collecte toutes les informations deman-
dées par l'utilisateur, et arrive sur la der-
nière étape : générer un joli résultat. 

C'est le plus souvent le fichier HTML 
qui sera affiché directement par le navi-
gateur de l'utilisateur. Parfois, il est accom-
pagné des images générées d'une maniè-
re dynamique, comme des graphiques ou 
des schémas. Le résultat est plus rarement 
présenté sous la forme d'un fichier PDF. 

Chacun des éléments cités est géné-
ré par PHP de manière différente. Vous 
créez du HTML directement ou à l'aide 
des modèles. Pour dessiner des graphi-
ques et des schémas, vous avez recours 
à des bibliothèques plus ou moins spécia-
lisées (p. ex. PHPlot, GD). Pour créer des 
fichiers PDF, vous avez besoin d'autres 
outils encore. 

Il arrive souvent qu'il ne faille que quel-
ques commandes seulement pour collecter 

Un équivalent gratuit de MS Office, 
OpenOffice.org, peut être utile non seulement 
sur le bureau, mais il est aussi possible de s'en 
servir en tant que serveur pour générer des 
documents HTML et PDF.

les données et 90 % des applications en 
PHP constituent le code qui est chargé de 
les afficher et les formater. Des program-
mes difficiles à modifier sont ainsi créés ; 
ils dépendent de nombreuses bibliothè-
ques externes, ils contiennent beaucoup 
d'erreurs qui n'apparaissent que dans les 
situations particulières – bref, ce sont de 
mauvais programmes. Dans de nombreux 
cas, il est possible de faire autrement ; 
dans cet article, nous essayons de reje-
ter le formatage des résultats en dehors du 

OpenOffice et PHP,
comment créer des rapports 
efficaces pour le Web ? 
Filip Dreger

Le CD contient les scripts pré-
sentés dans l'article ainsi que 
les feuilles qui les accompa-
gnent. 

1. http://www.openoffice.org/ – 
site du projet OpenOffice.org

2. http://www.oooforum.org/ 
– forum officiel de 
OpenOffice.org – il dispose 
d'une partie parfaite pour les 
développeurs

3. http://www.openoffice.org/
dev_docs/source/sdk
– OpenOffice.org SDK

Sur le réseau

Sur le CD

Ce qu'il faut savoir ...
Vous devriez avoir les bases sur PHP 
et quelques connaissances du package 
OpenOffice.org

Cet article explique ...
Nous vous montrerons comment em-
ployer OpenOffice pour générer des pa-
ges avec de nombreux effets pour votre 
site Web. Pour ce faire, nous créons une 
application simple qui se sert de PHP et 
OpenOffice comme un moteur pour gé-
nérer les graphiques côté serveur.
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code PHP. Nous nous servirons d'un mo-
teur extérieur qui non seulement formate le 
texte mais aussi se charge des graphiques 
et en plus, propose les données sous for-
me de fichiers HTML et PDF. Ce sera tout 
simplement un package gratuit fonction-
nant du côté de serveur : OpenOffice.org. 

Première approche : 
page statique 
Un travail avancé en PHP avec le packa-
ge OpenOffice.org est une question as-
sez complexe qui nécessite de bien con-
naître l'API de OpenOffice ; de plus, on 
s'y sert souvent de technologies impos-
sibles à transférer entre les plates-formes 
Linux et Windows. Nous essayerons de  
contourner ce problème en voyant ce que 
nous pouvons obtenir en utilisant la tech-
nologie Unix, autrement dit, le lancement 
de l'application à partir du shell. 

Tâche
En pratique, la technique décrite est em-
ployée dans le cas d'un grand nombre de 
données mais pour commencer nous es-
sayerons quelque chose de plus simple. 
Imaginez une petite entreprise, par exem-
ple, un atelier d'architecture. L'un des do-
cuments clés qui décrit son état financier 
est un cashflow, autrement dit, un sché-
ma présentant les entrées et les sorties 
d'argent de la caisse de l'entreprise. Cas-
hflow est indispensable pour gérer les fi-
nances, il peut par exemple indiquer que 
même si le bilan annuel est positif, le sol-
de en mars est négatif et donc qu'il faudra 
demander un crédit ; ou encore : entre les 
mois de mai et d'août, une somme impor-
tante d'argent se trouvera sur le compte
et il sera donc possible de déplacer à cette 
période un investissement prévu. 

Supposons que votre tâche consis-
te à créer un site Internet présentant le 
cashflow courant d'un atelier d'architectu-
re imaginé dans un format lisible, doté de 
graphiques ; supposons en plus que tou-
tes les données se trouvent dans la base 
(vous n'écrirez donc pas de module pour 
les y saisir). 

Feuille de calcul
Dans un premier temps, il faut saisir le 
cashflow dans la feuille de calcul. Ce 
n'est pas un travail ambitieux mais c'est 
plus simple à faire que créer un template 
Smarty similaire. 

Votre cashflow a (comme le présen-
te la Figure 2) treize colonnes : une pour 
chaque mois et une pour un bilan. Les li-
gnes supérieures contiennent les sour-
ces de revenus différentes ; je n'en ai 
imaginé que deux, l'une principale (dans 
le cas de notre atelier d'architecture, il 
peut s'agir par exemple d'un paiement 

pour un projet réalisé) et l'autre supplé-
mentaire (peut-être de petits projets gra-
phiques ?). Les lignes inférieures con-
tiennent toutes sortes de dépenses : lo-
cation du bureau, paie des employés
et publicité.

Mis à part les colonnes de données, 
le classeur contient plusieurs formules qui 

Figure 1. OpenOffice.org est meilleur que PHPlot

Listing 1. Macro qui exporte la feuille au format HTML, générée automatiquement 
par OpenOffice.org

sub export
rem ----------------------------------------------------------------------

rem define variables

dim document   as object
dim dispatcher as object
rem ----------------------------------------------------------------------

rem get access to the document

document   = ThisComponent.CurrentController.Frame

dispatcher = createUnoService("com.sun.star.frame.DispatchHelper")

rem ----------------------------------------------------------------------

dim args1(1) as new com.sun.star.beans.PropertyValue
args1(0).Name = "URL"

args1(0).Value = "file:///C:/Program%20Files/NuSphere/TechPlat/apache/htdocs/php/

cashflow.html"

args1(1).Name = "FilterName"

args1(1).Value = "HTML (StarCalc)"

dispatcher.executeDispatch(document, ".uno:SaveAs", "", 0, args1())

rem ----------------------------------------------------------------------

dim args2(1) as new com.sun.star.beans.PropertyValue
args2(0).Name = "URL"

args2(0).Value = "file:///C:/Program%20Files/NuSphere/TechPlat/apache/htdocs/php/

cashflow.sxc"

args2(1).Name = "FilterName"

args2(1).Value = "StarOffice XML (Calc)"

dispatcher.executeDispatch(document, ".uno:SaveAs", "", 0, args2())

End Sub
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introduisent les revenus et les dépenses 
additionnés dans les endroits appropriés 
pour chaque mois, ainsi que les sommes 
annuelles de revenus et de dépenses puis 
un bilan mensuel. 

Rendre le classeur plus joli
Vous pouvez colorer les cases du clas-
seur, vous pouvez vous servir de polices 
différentes et placer un graphique sta-
tique, ajouter des commentaires et des 
explications. Actuellement, l'exportation 
du classeur d'OpenOffice en HTML lais-
se encore beaucoup à désirer (alors que 
l'exportation en PDF est vraiment bonne), 
donc une partie des formatages utilisés ne 
sera pas très bien rendue dans la version 
Web du document : il faut donc faire ici 
des tests pour obtenir une bonne version. 

La caractéristique la plus intéressante 
probablement du classeur Calc est l'option 
d'illustrer les données à l'aide d'un graphi-
que qui change de façon dynamique avec 
le changement des valeurs de la table. 

J'ai décidé de présenter un bilan men-
suel sur un graphique à barres. Pour ce 
faire, il suffit de sélectionner avec la sou-
ris les douze cases de données à illustrer 
(cases de C23 à N23) et de sélectionner 
Insert->Chart dans le menu. Cette option 
appelle le créateur automatique qui per-
met de choisir le type de graphique (vous 
avez à votre disposition plusieurs dizaines 
de types, y compris les graphiques à trois
dimensions très spectaculaires), son nom, 
les descriptions sous les axes, etc. 

Vous pouvez glisser le graphique prêt 
à l'endroit choisi, puis le modifier (à l'aide 
d'un menu contextuel). Les amateurs d'une 
conception embellie des sites Internet peu-
vent travailler un peu plus en détail le gra-
phique : les polices, les couleurs, les op-
tions avancées des graphiques à trois di-
mensions ; vous pouvez éclairer le graphi-
que avec une lumière de différentes cou-
leurs et un angle d'éclairage donné, vous 
pouvez attribuer des textures et divers ty-
pes de matériaux : transparent, brillant, 
mat, etc. à chaque élément du graphique. 

Et après ?
Quand vous terminez de créer le clas-
seur, vous le remplissez – pour l'instant,
à la main – avec les exemples de don-
nées (le CD inclus au magazine contient 
ma version du document) ; remarquez 
aussi que les graphiques réagissent aux 
changements des données saisies dans 
le classeur et s'actualisent. 

Vous verrez maintenant comment 
l'ensemble se présente dans un naviga-

teur. Vous sélectionnez  Project->Save As 
dans le menu, vous précisez le type de fi-
chier comme HTML et c'est tout. Open-
Office génère le fichier HTML et les fi-
chiers de graphiques, exportés au format 
JPG. À ce moment-là, il vous est possible 
d'utiliser n'importe quel navigateur pour 
visualiser les résultats de votre travail : re-
gardez l'exemple de la Figure 3.

HTML à tout moment 
Pour l'instant, vous n'avez pas obtenu 
grande chose : il est vrai que vous pou-
vez exporter le classeur au format HTML 
mais premièrement, vous devez le faire
à la main et deuxièmement, vous ne pou-
vez saisir les données qu'à la main. Pour 
bénéficier d'OpenOffice lors de la géné-
ration des pages, il faut automatiser les 
deux processus. 

Commençons par automatiser l'expor-
tation : en l'implémentant, vous aurez les 
connaissances nécessaires à la deuxiè-
me partie de la tâche. 

Notre solution est simple : vous créez 
une macro qui enregistre le classeur en 
HTML et ensuite, fermez OpenOffice. En-
suite, vous les liez à l'événement on do-
cument open de votre tableur. Le charge-
ment de la feuille entraînera ainsi son ex-
portation en HTML et ensuite, la ferme-
ture automatique. Il sera ainsi possible 
d'utiliser OpenOffice au niveau du shell 
et donc d'utiliser n'importe quel langage 
script doté de la commande system(), par 
exemple PHP.

Gestion des macros
en OpenOffice.org
Les programmeurs n'aiment pas trop les 
suites bureautiques ; il serait difficile d'en 
être étonné. Heureusement, la gestion des 
macros dans le package OpenOffice.org 
est assez pratique. À partir de la version 
1.1.0, il est également possible d'enregis-
trer une macro, et il n'est plus nécessai-
re d'apprendre le langage assez « exoti-
que » : StarBasic.

Figure 2. Graphique placé dans la feuille de calcul 

Figure 3. Page HTML statique générée 
par OpenOffice.org

Figure 4. Gestionnaire de macros 
OpenOffice.org
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Au travail. Dans un premier temps, 
vous ouvrez un fichier avec un classeur. 
Dans un second temps, vous sélection-
nez l'option Tools->macros->record macro 
dans le menu. Vous verrez apparaître
à l'écran une fenêtre supplémentaire do-
tée d'un bouton Stop Recording ; désor-
mais, toutes les opérations sont enregis-
trées. Vous sélectionnez File->Save As 
dans le menu et enregistrez le classeur en 
HTML. Vous sélectionnez de nouveau Fi-
le->Save As et enregistrez la feuille en tant 
que fichier SXC (pour retourner au point de 
départ). Vous appuyez sur Stop Recording
et vous verrez le gestionnaire de macros, 
similaire à celui de la Figure 4. 

À gauche de la fenêtre, vous pouvez 
sélectionner l'endroit où vous enregistrez 
la macro : il peut s'agir d'un des modu-
les d’OpenOffice, disponible pour chaque 
document, ou d'un module privé, présent 
à l'intérieur de la feuille. Je vous propo-
se cette deuxième solution. Vous pouvez 
choisir le nom de votre nouvelle macro 
dans le champ texte en haut : par exemple 
export. Après l'avoir décidé, vous cliquez 
sur le bouton Save à droite de la fenêtre. 

Regardez comment se présente la 
macro saisie en Basic, utilisé par le pac-
kage OpenOffice.org. Pour le voir, vous 
appelez de nouveau le gestionnaire de 
macros : Tools->Macros->Macro... Vous 
appuyez sur la touche edit et vous ver-
rez l'IDE intégré à OpenOffice.org ain-
si que le code présenté sur le Listing 1 
(vous voyez sur ce listing que le code 
de la macro contient les chemins abso-
lus au fichier avec la feuille et son équiva-
lent en HTML ; si vous voulez placer ces 
fichiers à d'autres endroits, il faut modifier 
ces valeurs). Peu d'utilisateurs de Open-
Office se rendent compte que ce pac-
kage contient un environnement de dé-
veloppent aussi puissant. Il contient non 
seulement un IDE pratique pour écrire en 

Basic et doté d'un éditeur avec une mi-
se en évidence de la syntaxe, d'un dé-
bogueur mais aussi une gestion de Java, 
StarBasic et un interpréteur de Python 
complet intégré. 

Profitons-en pour ajouter à la macro 
des commandes de fermeture d’Open-
Office avant la ligne End Sub :

document.close(true)

stardesktop.terminate()

Il n'est pas nécessaire de comprendre ces 
lignes. Si vous êtes toutefois curieux, je 
vous invite à lire la documentation de l'API 
d’OpenOffice.org, disponible sur le site 
Internet www.openoffice.org et sur le CD
inclus au magazine. 

Attribuer les macros
aux événements
Pour obtenir le résultat souhaité, il est né-
cessaire de configurer le document de sor-
te que la macro export se lance à chaque 
fois qu'il soit ouvert. Vous pouvez réaliser 
cette opération au niveau du gestionnai-
re de macros. Vous vous servez du bou-
ton Assign : une fenêtre à part s'affiche, si-
milaire à celle de la Figure 5. La descrip-
tion des événements, auxquels il est pos-
sible d'attribuer la macro, constitue sa 
plus grande partie. Puisque nous souhai-
tons que la macro se lance à chaque char-
gement du document, nous l'attribuons
à l'événement open document.

Améliorations ultimes
Puisque les macros peuvent contenir 
n'importe quels documents, y compris 
les programmes potentiellement dange-
reux, OpenOffice est doté d'un méca-
nisme de sécurité qui interdit de lancer 
les macros provenant d'une source in-
certaine. Si vous voulez que votre feuille 
fonctionne d'une manière complètement 
automatique, vous devez consacrer un 
moment pour configurer la suite bureauti-
que. Vous ajoutez un répertoire avec une 
feuille à la liste des répertoires de con-
fiance dans le menu appelé Tools->Op-
tions (grâce à cette démarche, la macro 
se lancera sans que vous deviez le con-
firmer à la main). Il faut également déco-
cher l'option Load/Save->HTML Compa-
tibility->Display warning dans la même 
fenêtre. Sinon, à chaque fois que vous 
tentez d'exporter la feuille contenant des 
macros dans un fichier HTML, une fenê-
tre d'avertissement s'affichera.

Contenu dynamique 
Actuellement, quand le fichier cashflow.sxc 
est ouvert (par exemple, par le program-
me en PHP que vous voyez sur le Lis-
ting 2), une page HTML se crée automa-
tiquement. Il vous reste – peu de choses ! 
– à faire en sorte que la page générée par 
OpenOffice.org contienne les données dy-
namiques, donc qu'elle soit intégrée au 
système entier de comptabilité. 

Pour montrer comment intégrer PHP 
à OO, la provenance des données n'est 
pas vraiment problématique, supposez 
que dans une situation réelle, elles pro-
viendraient d'une application existante 
de base de données, contenant toutes les 
transactions réalisées par cette entrepri-
se imaginée. 

Comment PHP, transféra-t-il les don-
nées à la feuille ? Il existe de nombreu-
ses méthodes dont certaines nécessi-
tent d'utiliser une base de données com-
mune (OpenOffice.org est doté de tous 
les outils qui servent à se connecter aux 
serveurs distants et locaux de bases de 
données populaires) ou  de transférer 
les données dans un fichier texte. Nous 
appliquerons une solution très naturel-
le pour les programmeurs des applica-
tions Web, permettant d'intégrer rapide-
ment le package à notre projet : nous pla-
cerons les données de Calc sur une sim-
ple page Web. 

Figure 5. Attribution des macros aux 
événements 

Figure 6. Les données de cette table 
seront placées automatiquement dans la 
feuille

Listing 2. Programme qui génère 
la page cashflow.html (version sous 
Windows)

<html><body>

<?php

  system('cashflow.sxc');

?>

<a href=cashflow.html>

  cashflow</a>

</html></body>



OpenOffice et PHPOutils

www.phpsolmag.org26 PHP Solutions N° 3/2005

Une simple table
Pour ne pas vous occuper de la logique 
d'application mais de la génération d'un 
rapport, vous transmettez les données
à Calc à la main ; vous écrivez une page 
Web statique contenant deux tables : l'une 
avec les revenus annuels, l'autre avec les 
dépenses annuelles de l'atelier d'architec-
ture. Du point de vue d'OpenOffice.org,
il n'existe aucune différence quand les 
données sont chargées d'une page sta-
tique ou d'une page dynamique, générée 
par un script PHP. 

Vous souhaitez introduire des informa-
tions concernant les revenus (deux lignes 
de douze cases) et les dépenses (trois li-
gnes de douze cases) à la feuille réali-
sée auparavant ; il faut donc placer deux 
tables sur la page Web. Vous attribuez 
l'identifiant in (<table id='in'>) à la pre-
mière d'entre elles et out à la seconde.

La page avec les tables est très mo-
deste (Figure 6) mais vous n'allez de tou-
tes façons donner son adresse à person-
ne. Elle sert de source de données pour 
la feuille. 

Vous placez les tables sur le Net sous 
une adresse que vous pouvez voir en lo-
cal ; dans mon cas, il s'agit de http://
localhost/php/index.html.

Retour à la feuille
Vous chargez la feuille de nouveau. Vous 
sélectionnez les cases où vous voulez 
placer un contenu dynamique ; dans un 
premier temps, il s'agit des lignes décri-
vant les revenus. Vous sélectionnez donc 
Insert->External data dans le menu. La Fi-
gure 7 présente la boîte de dialogue qui 
s'affichera. Quand vous saisissez l'adres-
se URL de la page préparée auparavant 
(en désignant obligatoirement le protoco-
le : http://), OpenOffice s'y connecte et af-
fiche toutes les tables disponibles sur la 
vitrine. Puisque vous avez attribué aux ta-
bles les identifiants faciles à retenir, vous 
pouvez à présent sélectionner rapidement 
la source de données nécessaire : dans 
un premier temps, vous sélectionnez la ta-
ble in et appuyez sur OK. OpenOffice.org 
télécharge les données, en se servant de 
HTTP et les place à un endroit sélection-
né de la feuille. Vous placez les données 
de la table de dépenses (out) aux endroits 
adéquats de manière analogue. 

Vous avez ainsi créé deux liens dans 
la feuille : les sources de données exté-
rieures auxquelles Calc se reporte pour 
actualiser les cases. Si vous vouliez mo-
difier ces sources (par exemple, suppri-
mer les cases non actuelles), vous trou-
vez les options nécessaires dans le me-
nu : Edit->Links.

Il reste une dernière opération : il faut 
sélectionner de nouveau Tools->Options 
et ensuite Spreadsheet->General. Si vous 
n'y cochiez pas l'option Always dans Upda-
te links when opening, l'ordinateur deman-
derait s'il faut actualiser les données des 
liens et attendrait la réponse de l'utilisa-
teur à chaque ouverture de la feuille. Ceci 
rendrait impossible le travail automatique 
dans le mode de traitement par lots. 

Qu'avez-vous obtenu ?
Résumons. Actuellement, vous disposez 
d'un fichier contenant une feuille de calcul 
qu'il est possible de lancer dans le mode 
de traitement par lots, à partir de la conso-
le. Sous Linux, vous l'obtiendrez à l'aide de 
la commande ooffice cashflow.sxc et sous 
Windows – à l'aide de cashflow.sxc.

Il est également possible de lancer 
la feuille au niveau de PHP au moyen 
de la commande system (en cas de pro-Figure 7. Choix de la source des données 

dynamiques 

Listing 3. Application simple en 
PHP qui génère un graphique à trois 
dimensions selon le tableau 4x4, 
modifiable via le formulaire

<html><body>

<form name='txt' action='index.php' 

  method='get'>

<?php

  $fp = fopen('store.txt', 'r');
  $data = fgets($fp, 2000); 
  fclose($fp);
  echo "<input type='text' 
   name='cont' size='40' 

   maxlength='256' 

   value='$data'>";

?>

<input type="submit" 

  value="submit">

</form>

<?php

  $table=$_GET['cont'];

  if ($table!=""){
  $fp = fopen('store.txt', 'w') 
    or die ("can not 
      open the file");

  fputs($fp,$table); 
  fclose($fp);
  system("cashflow.sxc");}     

  if ($table==""){
  $fp = fopen('store.txt', 'r');
  $table = fgets($fp, 2000); 
  fclose($fp);}     
  $table=split(" ",$table);
?>

<table id="data" summary="" 

  border="1">

<tr>

<td><?echo $table[0];?></td>
  <td><?echo $table[1];?></td>
  <td><?echo $table[2];?></td>
  <td><?echo $table[3];?></td>
</tr>

...

<tr>

  <td><?echo $table[12];?></td>
  <td><?echo $table[13];?></td>
  <td><?echo $table[14];?></td>
  <td><?echo $table[15];?></td>
</tr>

</table><br>

<a href="cashflow.html">

  click here</a>

</body></html>

Lancement de OO sur le serveur
Il existe deux problèmes élémentaires liés au lancement de OO à partir d'un script PHP. 
Le premier d'entre eux : droits d'accès (ce problème est plus important sur les serveurs 
Windows et les ordinateurs des développeurs), le second : absence de serveur X (ce 
problème concerne toute sorte d'Unix).

• Si vous avez des problèmes pour lancer le script sous Windows, il faut vérifier les droits 
dont dispose l'utilisateur Apache permettent de lancer OpenOffice. Une solution rapide 
sur l'ordinateur d'un développeur consiste à modifier la configuration du service Apache 
pour qu'il fonctionne à partir du compte de l'utilisateur. 

• Si vous voulez lancer OpenOffice sur un ordinateur dépourvu de serveur X, vous 
pouvez vous servir de la bibliothèque xvfb, qui fait partie des environnements XFree
et Xorg, ainsi que du script xvfb-run. Face aux applications, le script et la bibliothè-
que font semblant d'être un système X-Windows complet qui n'affiche rien et ne sup-
porte pas les périphériques d'entrée. Pour lancer OpenOffice.org en vous servant de 
ce script, il suffit d'utiliser cette commande : xvfb-run -a ooffice. Dans certains cas,
il ne faut pas oublier de configurer les variables d'environnement, comme $HOME.
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blèmes, reportez-vous à l'encadré Lan-
cement d'OO sur le serveur). Après 
avoir chargé la feuille, OpenOffice.org 
actualise son contenu d'après la pa-
ge locahost/php/index.html, il effectue 
les calculs indispensables et génère les 
graphiques. Ensuite, la macro export 
est activée ; elle enregistre la feuille 
avec les graphiques au format HTML 
et termine le travail de la suite bureau-
tique. À présent, vous trouverez la ver-
sion actuelle de la feuille ainsi que ses 
graphiques à l'adresse localhost/php/
cashflow.html ; il est possible de visua-
liser cette version à l'aide d'un simple 
navigateur. Dans notre version, la pa-
ge localhost/php/index.html est statique 
mais en pratique, elle serait générée par 
le script PHP selon les renseignements 
fournis par la base de données du systè-
me comptable. 

Le Listing 2 présente un petit pro-
gramme qui lance le processus de géné-
ration du rapport et qui permet de visuali-
ser ses résultats.

Le Listing 3 présente en revanche 
un autre exemple d'emploi du package 
OpenOffice : le générateur de graphique 
à trois dimensions doté d'une simple in-
terface utilisateur. Si vous comparez le 
contenu du Listing aux résultats de son 
fonctionnement présentés sur la Figure 
9, vous serez convaincus qu'une grande 
partie du travail peut être automatisée au 
moyen des classeurs.

En fait, le seul inconvénient dans 
cet exemple est que le temps d'actuali-

sation du graphique peut s'élever à plu-
sieurs secondes, après avoir cliqué sur 
Submit ; pendant ce temps, la version 
précédente du graphique se trouve sur 
le Net.

Que pouvez-vous 
ajouter ?
Quand vous maîtrisez déjà les bases 
d'OpenOffice en traitement par lots, vous 
pourrez obtenir facilement beaucoup plus. 
À titre d'exemple, en enregistrant la macro 
export, vous pouvez enregistrer la feuille 
non seulement au format HTML mais 
aussi PDF (vous pouvez voir un PDF gé-
néré à partir de la feuille sur la Figure 8). 
Il est également possible d'ajouter à la 
feuille les éléments du formulaire et l'inté-
grer ainsi plus encore à votre site Web. 

Avantages et inconvénients 
Le plus grand avantage de la réalisa-
tion de pages au moyen d’OpenOffice 
consiste en fait que vous pouvez ajou-
ter très rapidement à l'application des 
pages très complexes d'un point de 
vue graphique et conceptuel, sans de-
voir écrire de code. De plus, vous pou-
vez encourager des personnes, qui ne 
sont pas des programmeurs qualifiés, 
à concevoir les rapports : par exemple, 
encourager un comptable à créer des 
feuilles de calcul et les utiliser comme 
une base pour les sous-pages de votre 
site : OpenOffice charge sans problème 
les feuilles Excel. 

Le défaut de cette solution est qu'el-
le prend beaucoup de ressources. Elle
se prête mieux en intranet que dans une 
vitrine souvent visitée. D'un autre cô-
té, si vous concevez bien votre applica-
tion, vous pouvez vous servir d’Open-
Office dans certains systèmes qui tra-
vaillent sous une charge importante :
il suffit de ne pas générer un HTML sé-
paré pour chaque visiteur mais d'actuali-
ser le fichier à chaque changement des 
données d'entrée. 

Options supplémentaires
L'utilisation d’OpenOffice dans le mode 
de traitement par lots n'est qu'un début. 
Ce programme est doté d'une structure 
à base de composants et il est possible 
de manipuler tous ses aspects au moyen 
des composants COM sous Windows ou 
UNO sous Linux et Windows. C'est beau-
coup plus compliqué mais cette démar-
che supprime toutes les contraintes de 
la méthode de traitement par lots, admise 
dans cet article. n

Figure 8. Il est possible d'exporter la feuille au fichier PDF

Figure 9. Page générée par le programme du Listing 3 et une feuille de calcul adéquate


